
Using Crystal Reports with Lucity 

Advanced – 1 

The fifth of a seven-part series, this workbook is designed for Crystal Reports® users with some 

experience, who wish to explore the power of adding graphics to their reports.   

Graphs help you visualize data.  They show patterns and trends at-a-glance.  In addition, they add 

impact to your ideas.   
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Developing a Graphical Report 
 
Crystal Reports allows you to add graphs in the Report or Group Header and Footer sections of a report.  

In the following step-by-step example, we’ll create a report showing the Sewer Work Orders grouped 

by categories.  We’ll add a bar graph showing number of Work Orders for each Sewer category and a 

pie chart to show percentage of Work Orders for each category. 

1. We will modify the Sewer Work Orders By Category Report (WOCatSum.rpt) from the Work 

Order module. From the Work report folder open LC_WOCatGraph.rpt. 

2. Change the Title to “Sewer Work Orders by Category Report.” 

3. Next, we will limit the work orders to those for Sewer assets. 

a. Open Select Expert. 

b. Open the WKORDER table. 

c. Highlight WO_INV_ID and click OK. 

d. Select “is between” from the drop down box and type in 2 and 6 (2:Structure, 3:Pump 

Station, 4:Pump, 5:Service Lateral, 6:Pipe).   

e. Then, click OK.  

 These numbers come from the WKCATINV table.  

f. The Select Expert formula now looks like this: 

{WKORDER.WO_INV_ID} in 2 to 6 

Preview 

 

4. Use the Insert Section Below option to add an additional Report Footer section.   

5. Increase the new section (Report Footer b) size to about 3 inches to make room for the graph. 

Inserting a Graph 

1. Click Insert Chart . 

2. Place the “box” where the graph is to be located in the Report Footer b section. 

3. The Chart Expert may automatically open, where you will proceed with the Data tab.  

 OR - Crystal may guess what data and type of graph you wish to use and drop the graph in.  If 

 the graph shows up then you will need to right click in the graph box and select Chart Expert to 

 make any revisions. 
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Chart Expert, Data tab 

 
If Crystal has guessed on your data, the following should appear: 

  

 

4. If this is correct, then you should look at the options within the other tabs to modify as 

needed.  If this isn’t correct, then click on Advanced and set up the data as follows: 
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Chart Expert, Type Tab 

 
Highlight the “Side by side bar chart” option. 
 

 
 

Chart Expert, Axes tab 
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Chart Expert, Options tab 

 

 

Chart Expert, Text tab 
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The graph should look similar to the following with the current titles:  

 

5. To modify the report, right click on the graph and select Chart Expert. 

6. Change the names in the Text tab to clarify the graph titles. 

o Uncheck the Auto-Text boxes to allow modification of the text in the associated field. 

  

7. There may be an issue with overlapping of the Group axis title and the axis labels.  One option 

to correct this is simply to move the Group axis title (Category). 

a. Click on the axis title (Category) which activates black dots around the edges. 

b. Click and drag the title to the new location. 
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8. Another option would be to remove the axis values and let the legend suffice. 

a. Click on one of the Group axis labels (such as Sewer Pipe) until it has the dotted box 

around it. (It may take multiple clicks) 

b. Right click within this box and select Format Axis Label… 

c. Under Color select “Transparent” and then OK. 

d. Now the Legend will explain the categories. 
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9. If the graph works better with Group Axis values, then the legend is redundant information and 

could be removed.  (Of course the Group Axis Label color would need to go back to black.) 

o To remove the Legend open the Chart Expert – Options tab. 

o Uncheck the “Show legend” box.  Then OK. 

 

Chart Expert, Color Highlight 
Sometimes it is helpful to use specific colors for certain groups.  These can be set up in the Color 

Highlight tab using the drop down boxes to select the values. 

a. Click New 

b. Select the values and color in the Item editor section. 

c. Repeat New and Values for each Category that needs a specific color. 

d. Select OK. 
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Preview 
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Right click on the chart for further options.  Examples of these options are displayed on the following 

pages.  Options vary depending on the type of graph you are working with: 

 Chart Options, Appearance tab 

 

 

Chart Options, Titles tab 

 

 



Advanced Crystal 1  11 

Chart Options, Data Labels tab 

 

 

 

Chart Options, Legend tab 
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Chart Option, Gridlines tab 

 

 

Chart Options, Axes tab 

 

 

You can play with the options until you achieve the look that best portrays your information. 

                                                                                                                                              Example 22A 
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Chart Type 
In the Chart Expert, Type tab, you can select the Chart Type.  These include Bar, Pie, Line, Gauge, 

etc.  

Pie Chart  
If the Pie option had been chosen instead of the Bar Graph pictured above, the graph we created would 

look like this: 

 

The Legend needs to be added back in. (Options tab) 

 

The Categories are shown as percentages so the title should reflect this. (Text tab) 

 

                                                                                                             Example 23A and Example 24A 
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Gauge Chart 

Gauge reports give a unique perspective on data.  An expenditure report can show where you are with 

your spending for the year.  You can set the values and colors of your bands.  At a glance the pointer 

will show you where you are now and if you need to worry about the next few months of spending or 

not. 

In the Work report folder open the Fiscal Year Gauge Report (DashBudgetYearGauge.rpt).  The report 

is set up as follows: 
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1. To select the colors in the gauge, right click on the gauge chart box.  

2.  Select Chart Options.   

3. Click on the "Quality Bands" tab. You can set up to 5 "bands" or ranges of values.   

4. Click OK to save. 

  

5. For each band to have an individual color, you have to click each individual band to highlight. 

6. Right click and select "Format Selected Item…".   

7. Choose the Foreground Color. 

8. Click OK. 
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Cross – Tabs 

Cross-Tab   is a row and column object that can be helpful in creating a type of spreadsheet.  It is 

also useful in creating and modifying graphs. 

It was necessary to use a Cross-Tab object to fix some graphs that were originally created using just 

the Crystal Chart option.  

One graph looked like this: 

 

 

 

As you can clearly see, the chart legend poses the most obvious issue.  The placement of the bars is an 

additional concern.  The “0 to 10”, “10 to 20”, and “Others” bars are placed after the “90 to 100” bar 

instead of before the “20 to 30” bar. 

 

“This behavior occurs because Crystal Reports takes the first grouping in the data set and creates a sorted view of this 

data before creating the graph. When this first grouping does not contain all the possible items to be shown in the 

legend, Crystal Reports will sort the selection and add any new items to the end of the legend list.”  

http://technicalsupport.businessobjects.com 

 

The Arterial grouping did not have bars for “0 to 10”, 10 to 20” or “Others”.  Thus, the legend was 

created without these ranges.  As additional groupings were added, the legend picked up the missing 

PCI values. 

A Cross-Tab object was used to correct these issues. 

 

 

http://technicalsupport.businessobjects.com/
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Creating a Cross-Tab Report 

We will create a Cross-Tab report for Street Pavement Conditions to be run in the Pavement 

Manager>>Field Inspections module.  A cross-tab object can be brought into an existing report or a 

new report can be created using the Cross-Tab Report Wizard. 

Report to be created: 

 

This module has fields utilizing several tables so it would be worthwhile to check Field Definitions to 

make sure we bring in all of the pertinent tables.   

We will be using the following fields: 

 Inventory PCI (STPVFLD_FD_PCI) 

 Total Area (STSUBSEG_SB_TAREA) 

 Street Classification (STNET_SN_CLAS_TY)  
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1. Open Crystal Reports and select New Reports >> Cross-Tab Report Wizard. 

2. Expand Create New Connection. 

3. Open ODBC (RDO). 

4. Within Data Source Selection select GBAStret001 >> Finish (You may need to provide User 

Name and Password here). 

5. Move the necessary tables from Available Data Sources to Selected Tables. 

 

6. Click Next and link as follows.  Remember to “Left Outer Join” between tables. 
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7. Click Next.  Set up the Columns, Rows, and Summary Fields as follows: 

 

8. Click Next.  At this time, we will skip the charting option.   

9. Click Next.  We would like to filter for the Most Recent Records (STPVFLD.FD_MST_REC). 
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10. Click Next.  Leave the Grid Style as Original. 

11. Click Finish.   

12. Save the report in the Street report folder as LC_PCIClass.rpt. 

A report has been created. 

This is the Cross-Tab object that has been created. 

 

 

 

It shows every PCI value (6.9, 7.75, 8.45…).  We would like to group the PCI values to make the data 

more manageable. 

 

 

 

 

 

 

 

 

 

 



Advanced Crystal 1  21 

Cross-Tab Expert, Grouping 

There are various options that can be set up in the Cross-Tab Expert. 

At this time the Group Options… will be set up. 

1. Right click in the empty top-left corner of the table and select Cross-Tab Expert… 

2. Click on the STPVFLD.FD_PCI field in the Rows box to highlight it.  

 

 

3. Click on Group Options…  This will open the various grouping options that we have previously 

used. 
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4. Using the drop down box below the field name, select “in specified order”. 

  

 

5. This should take you to the Specified Order tab.  If that tab does not open, click on the tab 

name. 

6. Enter the first group name. 

 “0 – 10” 

  

 

7. Click New.  (Or, you can click New and enter the group name in the Define Named Group 

box.) 
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8. Select “is between” from the drop down box.  Two boxes appear allowing you to set the upper 

and lower limits of the group.  Enter the appropriate values.   

9. Click OK and continue the process until all of the ranges have been entered. 

 

  

 

 

  

10. Click OK  

11. Click OK again to close the Cross-Tab Expert. 
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The report now looks like this: 

  

To see all of the number fields, the cells size will need to be increased. 

12. Click on one of the blocked out fields (######).  This will activate the sizing handles.   

13. Click and drag the sizing handle to increase the width of the cell.  All of the cells for this field 

will increase in size. 

14. Change the Column titles to Bold, right aligned and the Area values beneath to not bold. 

15. Save 
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These Cross-Tab options are worth reviewing.  The style might catch the eye of the reader to tempt 

them to read the data. 

Cross-Tab Expert, Style 

 

Cross-Tab Expert, Customize Style 

 

                                                                                                                                       Example 25A 
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Graph Using Cross-Tab Data 

We will now create a graph using the information from the Cross Tab object created in the previous 

example. 

1. Click on the report Design tab and increase the size of the Report Footer section to about 3”. 

2. Click on Insert Chart  or click on Insert and then Chart. 

3. Click the chart box frame into the Report Footer section. 

4. The Chart Expert dialogue opens.   

5. In the Data tab select Cross-Tab.  

6. Use the drop down arrows to choose the appropriate fields and formulas. 

 

 

7. Click OK.   
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The chart now looks like this: 

 

8. The Chart Expert can be used to modify the titles (Text tab). 
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9. To read the Group axis (x-axis) horizontally, click on one of the titles.   

10. Right click and select Format Axis Label.   

11. Change the rotation to Normal. 

 

12. Click OK.  The changes will be applied to the chart. 

  

 

13. The Cross-Tab object can be left at the top of the report in the Report Header, moved to the 

Report Footer or it can be suppressed, leaving the graph on its own. 
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Clean up modifications will probably be necessary such as the Report Title, date and time. 

 

 

 

14. Save the report in the Street folder as LC_PCIClass.rpt. 

                                                                                                                                      

Note:  “Because cross–tabs are calculated during the first report pass (While Reading 

Records), you cannot use second-pass formulas in cross-tabs.  You can use only formulas that 

calculate during the first pass.  However, you can base a chart or a map on a cross-tab, 

because cross-tabs are processed before charts and maps.”  The Complete Reference 

Crystal Reports 10, Peck, 2004       

 

                                                                                                                                     Example 26A 
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Cross-Tab Dates 
This report shows the number of Work Orders a person created in a specific date range.  It shows the 

number for each day and day of the week.  

 

 

 

 

IniDt formula: 

 Date({WKORDER.WO_INIDATE}) 

Day formula: 

 ["Sun", "Mon", "Tues","Wed","Thur","Fri","Sat"] [DayOfWeek({@IniDt})] 
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In the Customize Tab make sure the Suppress Subtotal box is checked. 

 

 

 

 

 

To format the date field, you can right click on the date field and choose Format Field then click on the 

Date tab and select the formatting. 
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Cross-Tab Column and Row Titles 
 

 

 

The titles “Leave Type” and “Employee” are part of the Cross-Tab.  Formulas were created for the titles: 

@Leave Type 

 “Leave Type” 

@Employee 

 “Employee” 

Then the cross-tab uses the formulas as the first field in the Columns and Rows choices. 
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The sixth of a seven-part series, this workbook is designed for Crystal Reports® users with some 

experience.  Here, you’ll learn to set up Hide (Drill-Down), Variables, Percentages and Commands.  

Issues with Web and Dashboard reports will be addressed. 
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Hide (Drill-Down) 
Sometimes, it’s useful to view a condensed version of a report, where the details are accessible only 

when needed.  This is often helpful when trouble shooting bad data.  This option is available when 

grouping data.  The following example will show you how to display the number of Work Orders for 

each category with the option to view the individual Work Orders within the categories. 

The main report looks like this: 

 

The hidden section of the Equipment category looks like this: 

 

 

1. We will modify the Work Order Summary Report (WOSum.rpt) from the Work Order module. 

From the Work report folder open LC_WOHide.rpt. 

2. Change the title to Work Orders by Category Report. 

3. Delete the Address column.   

4. Add the Category grouping and move the Category grouping to be the first grouping. 

5. Add a second Page Header section above the Column titles by placing the cursor on the left 

ruler section, click and wiggle to create the break. 

6. Move the Category title above WO # and remove the Category field. 

7. Increase the Group Header 1 section size. 

 

8. Right click in the Page Header b section, click Select All Section Objects. 



Advanced Crystal 2  4  

9. Drag the column titles into the Group Header 1 section, beneath Group #1 Name. 

10. Right click in the Page Header a section and select Merge Section Below. 

11. Add a column title called Count in the Page Header section.   

 

 

 

12. Create a count formula using the Summary button  to count the number of Work Orders 

(Distinct Count to deal with any filtering issues). 

a. Have the Count formula placed in the Group Footer 1 section.   

b. Move the formula to the Count column.   

 

 
13. Next, we will create a concatenated formula where fields can be “tacked together” to 

eliminate awkward spacing.  Create a new formula called Category.   

 
  if isnull({WKORDER.WO_CAT_CD}) then "" else {WKORDER.WO_CAT_CD}&"  "& 

  if isnull({WKORDER.WO_CAT_TY}) then "" else {WKORDER.WO_CAT_TY} 

 
14. Drag this formula into the Group Footer 1 section under the Category column title. 
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15. To the left of the report, right click in the Group Header 1 section and select Hide(Drill-Down). 

16. Repeat step 14 for the Group Footer 2a section. 

 

 
17. Preview the report to see how it looks.   

 

o To view the Work Orders within each category, double click the category code. 

 

 
 

18. Next, you should add a text line in the Page Header that instructs the report viewer to double 

click on the category code to view the individual work orders. 

 

 

                                                                                                                                      Example 27A 
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Variables 

Why Use Variables? 
One of the more important uses of variables is in reports that may be run with a filter of a “child” or 

“grid” field that could have multiple values.  Other uses are in running subtraction calculations in 

progressing records or passing information from a subreport to the main report.  There are many uses 

that only become apparent when the use of the standard formulas doesn’t work. 

A variable is a type of component that may be used in a formula.  A variable represents a specific item 

of data or a value.  It then acts as a placeholder for that value.  When a formula encounters a variable, 

it searches for the variable’s value and uses it in the formula. 

Unlike a constant value, which is fixed and unchanging, a variable can repeatedly be assigned different 

values.  When you assign a value to a variable, it maintains that value until you later assign it a new 

value.  Because of this flexibility, it is necessary for you to declare variables before you use them.  It is 

also frequently necessary to reset the variable. 

The original Work Order Category Summary Report (WOCatSum.rpt) looked like this: 

 

 

 

It was a very simple report which grouped on Category and used the Crystal Summary tool to calculate 

the Group Total and Grand Total.  This worked when the report was run without filters.   

 

 

 

There were certain filters that caused duplicate Work Order costs.  The problem filters are the fields that 

come from grid data.  In the Work Order module these would include Location, Assets, Tasks and 

Resources.  This occurs because of the filter statement being passed from Lucity to Crystal.  If there are 

two Tasks on a Work Order that are true for a Task filter being run, then the report will run the record 

twice.   
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When the report was run with a resource filter on Work Orders that have employees, these same 

categories looked like this: 

 

There is an obvious difference in the cost fields.  Instead of possibly going down due to records being 

filtered out that had no employees, the cost actually went up. Some work orders had multiple 

employees so the cost  was summed each time the filter was true.  The count was calculated using the 

Distinct Count option as opposed to the Count option for calculating so there was no duplication of 

records. 

To correct this issue we used grouping and variables.   

 

Declaring a Variable 
Each variable must be assigned a data type (string, number, currency, time, or date) and a name (your 

choice).  You also need to know the scope or degree to which the variable will be used:  

 Local – Variable will be used in a single formula. 

 Global – Variable will be used throughout the main report. This is Default if the scope isn’t 

stated. 

 Shared – Variable will be used throughout the main report and any subreports. 

 

1. To declare a variable, create a formula using the Formula Workshop or type it in.   

o Within the Formula Workshop, there are two options under Operators called Scope and 

Variable Declarations.   

o Open Scope and double click the option that you want (typically – Shared).   

o Open Variable Declarations which lists the correct format used in stating the Data Type.  

Double click the correct Data Type.   

o The correct format requires that the scope be placed before the Data Type. 

 
Shared numberVar  := ; 

 

 For just declaring a variable, you should remove the colon and equal sign “:=”. 
 

o The name for the variable goes after the Data Type. 

<Scope> <Data Type><VariableName>; 

Example:  Shared NumberVar Security; 

In our example, the Scope is Shared and the Data Type is NumberVar.  The Variable name is 

Security. 
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2. After the formula is created it needs to be placed in the report. 

Assigning a Value to a Variable 
After a variable has been declared, a value can be assigned to it.  The assigned value can be a direct 
value, formula, parameter, or the value of a field. 

<VariableName> := <Value> 

 
Example:  Security := {?ViewSecuredFields}; 

Declare and Assign 
You can also declare a variable and assign a value to it in one step.  In this case you would not have 

removed the “:=”. 

Example:  Shared NumberVar Security := {?ViewSecuredFields}; 

Evaluation Time 
Evaluation Times are statements that tell when the formula is to be evaluated.  If nothing is stated, 

Crystal Reports guesses what is appropriate for the data being used in the formula. Within the Formula 

Workshop these options can be found under Functions > Evaluation Time. 

 

 BeforeReadingRecords:  formulas are evaluated before the database records are read. 

 WhileReadingRecords:  formulas are evaluated while it is reading the database records. 

 WhilePrintingRecords:  formulas are evaluated while it is printing the database record data. 

 Evaluate After (x): formula forces this formula to calculate after the “x” formula. 

Typically WhilePrintingRecords is used. 

Using Variables in a Report 
 
One way to correct the WOCatSum.rpt report would be to use variables. 
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1. Add a second grouping on the Work Order Number, WO_NUMBER. 

2. Create a formula for the Work Order Cost (WOCost) and place it in the WO Number Group 

Footer 2. 

WhilePrintingRecords; 

Shared numberVar WOCost ; 

WOCost:={WKORDER.WO_TOTCOST} 

3. Create a formula to summarize the cost for the Category (CatWOSum). Add a new section 

below the WO Number Group Footer 2.  This is a second Group Footer (GF2b) for this section.  

Place this new formula in this section. 

WhilePrintingRecords; 

Shared numberVar CatTot ; 

Shared numberVar WOCost ; 

CatTot:= CatTot + WOCost 

4. Create a formula to summarize the total cost for all Work Orders (TotSum).  Place this in GF2b. 

WhilePrintingRecords; 

Shared numberVar TotWOCost ; 

Shared numberVar WOCost ; 

TotWOCost:= TotWOCost + WOCost 

5. Create a formula to reset or zero the Work Order cost variable (ZeroWO).  Place this in the WO 

Number Group Header #2 section. 

WhilePrintingRecords; 

Shared numberVar WOCost:=0; 

6. Create a formula to reset the Category Cost variables (ZeroCat).  Place this in the Category 

Group Header #1. 

                   WhilePrintingRecords; 

       Shared numberVar CatTot:=0; 

7. Create a formula to show the Category total cost (CategoryTot).  Place this in the Category 

Group Footer #1. 

                  WhilePrintingRecords; 

                  Shared numberVar CatTot ; 

                  CatTot 

8. Create a formula to show the Grand Total Cost (Total).  Place this in the Report Footer. 

WhilePrintingRecords; 

Shared numberVar TotWOCost ; 

TotWOCost 

9. Suppress the new Group Header and Footer sections.                        

                                                                                                                Example 28A 
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It depends on the report as to whether you use variables or running totals to solve filter issues.  At the 
time the report was revised the use of variables was the choice method to correct the issue. 

Variables are also very useful to pass information from a subreport to the main report. This was shown 

in Unlinked Subreports mentioned in Intermediate 2.  This is shown again here now that variables 

have been discussed.  

Unlinked Subreports 
There are times when the subreports do not need to be linked.  For example, you won’t need to link 

subreports if there are no connections to the main report.  In this situation, the subreport can share 

data using variables but does not necessarily share a database. 

Stand-alone reports can be brought in as subreports so that one report can bring in many reports or just 

the final values of these reports as a summary. 

In Lucity software the button captions may be altered to suit individual needs. These field captions 

may be reflected in the report by one of the following methods:   

 Edit the appropriate text object in the report as discussed in the related Beginning Crystal 

workbooks. 

 Pull the value that is stored in the database and display it on the report using an unlinked 

subreport. This is the setup for the User fields in the Custom tab. 

Lucity uses this type of unlinked subreport in many of the Detail reports.  The subreport is hidden in a 

Report Header.  It contains a formula declaring variables that are associated with the User button 

captions in the Custom tab. 

 

The @StoreUserBtns formula appears on the following page.  Note that this is only part of the formula.  

We’ve included this to make you aware of what happens behind the scenes.   

 Any line starting with // is just a comment; it is not part of the formula.   

The formula for each User button caption looks something like this: 
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Date Variables 
Date fields can be converted to a string type variable that can be easier to reset. 

 WhilePrintingRecords; 

 shared stringvar FirstNoticeDue; 

 
 if {WTBFNOTICE.BN_NOT_TY}="First Notification Sent" then 

 FirstNoticeDue:=totext({@NoticeDt}+90,"MM/dd/yyyy") 

 
The reset for this variable (FirstNoticeDue) is: 

 WhilePrintingRecords; 

 shared stringvar FirstNoticeDue:=""; 

Using Variables for Subtraction 
Crystal Reports is quite useful when adding numbers together but it gets pretty tricky when you want 

to find the difference in running numbers. 

In Water, the Meter Set Location module has a Flow Meter Location Usage Report (WTMtUsage.rpt) 

that is a good example of this.  It is modified here to a single Reading to clarify the subtraction 

process. 

 

 

The report is grouped on the Meter Location Number (Group 1) and then the Device ID (Group 2).   

 In GH1 there is a formula to reset the Location Usage (ZeroLoc): 

 shared Numbervar LocTot1:=0; 

 

 In GH2a there is a formula to reset the Device Usage (ZeroDev): 

 shared Numbervar MetTot1:=0; 

 

 In GH2b there is a formula to reset the Device Reading 1 value (ZeroPrev): 

  Shared Numbervar prevval1:=0; 
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 In Da there is a formula for the amount used (Diff1): 

  Shared Numbervar prevval1; 

 if PreviousIsNull ({WTMTMD.RM_READ1}) then 0 

 else if Previous ({WTMTMD.RM_READ1}) = 0 then 0 

 else if (previous ({WTMETDEV.MD_ID}) <> {WTMETDEV.MD_ID})then 0 

 else {WTMTMD.RM_READ1}-prevval1; 

 

 In Db there are two formulas: 

 (PrevVal) 

  Shared Numbervar prevval1; 

 prevval1:={WTMTMD.RM_READ1}; 

 (CalcTots) 

  shared Numbervar MetTot1; 

 shared Numbervar LocTot1; 

 MetTot1:=MetTot1 + {@Diff1}; 

 LocTot1:=LocTot1 + {@Diff1}; 

 

 In GF2 there is a formula for Device total usage (TotMet1): 

  shared Numbervar MetTot1; 

 MetTot1 

 

 In GF1 there is a formula for the Location total usage (TotLoc1): 

  shared Numbervar LocTot1; 

 LocTot1 
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Using Variables to Count for Section Suppression 
A report was created to view Street Subsegment information including its PCI on a given date.  A graph 

was created for each subsegment that had more than one date.  The graph needed to suppress when 

there were no or one date/PCI values. 

 

 

The (count) formula was created: 

 
 WhilePrintingRecords; 

 Shared numberVar cnt ; 

 cnt:=cnt +1 

 
Then within the Section Expert, GFa1 Suppress formula was added: 

 
 WhilePrintingRecords; 

 Shared numberVar cnt ; 

 cnt in[0,1] 

 
The section suppresses when cnt is equal to 0 or 1. 
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Comments to Non Comment Subreports 
Subreports may not be put in subreports.  Adding a Comment section that is in a separate XXMEMO 

table that requires certain criteria to be true to pull the correct data seems impossible to add to a 

section in a report that is already a subreport. 

There are a variety of ways to accomplish this task.  Not all work for the various scenarios. 

Option 1 – Variables 
 

A client wanted the Comment for Events added to the Work Order Detail Report (WODetail.rpt).  

Events is a subreport of this Report.  It was done as follows: 

 

 

 

1. Bring in the WKMEMO table and link left outer join. 

  

2. Group on the ID of the subreport table (WKWOEVENTS).   

3. Create a variable formula (Text) to grab the text of the correct Memo field. 

  WhilePrintingRecords; 

 Shared stringVar Text ; 

  

 If {WKMEMO.CO_FIELD}="WE_MEMO1" then 

 Text:={WKMEMO.CO_TEXT} 
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4. Create a reset formula (Zero) for this variable and place it in the Group Header section.  The 

zero in this case is a space “ “ instead of a zero (0) because it is a string variable. 

 

  WhilePrintingRecords; 

 Shared stringVar Text:=" "; 

 

5. Place the report information in the Group Footer section. 

6. Create another Group Footer section for the Comment. 

7. Place the Comment text formula (CommentTxt) in the second footer section.  Make sure this 

field is allowed to grow. 

 

  WhilePrintingRecords; 

 Shared stringVar Text ; 

 Text 

 

8. For the “Comments” text field use a suppress formula when the text variable is blank.  

 

  
 

  

 
 WhilePrintingRecords; 

 shared stringVar Text ; 

 Text=" " 

 
9. In Section Expert select Suppress Blank Section for the second Group Footer (GF1b). 

Option 2 – Grouping & Conditional Suppression 
Here is another way in which a Comment was brought into a subreport. 

The comment was added to the Notifications subreport within the Request Detail Report 

(ReqDetail.rpt). 
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1. Bring in the WKMEMO table and link with left outer join. 

 

2. Group on the WKREQNOT.RN_ID field and place the information from this table in the Group 

Header.   

3. In the Detail section place the information from the WKNOTCOM table and the Text field from 

the WTMEMO table. 

4. In the Section Expert, create a conditional suppression formula for the Details section. 

 

 

  {WKMEMO.CO_FIELD} <> "NC_MEMO1" 
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Grouping – More Advanced 

Group Sort Expert 
When a report uses grouping, the report automatically sorts on the first group and then within the 

group any other groups.  Each group can be sorted in ascending, descending or a specific order.  The 

Group Sort Expert  can be used to change the field the report will sort on. 

An example of this is the Supersegment Work Order Cost Summary Report – By Descending Cost 

(SupersegDWOCost.rpt). 

 

  

 

o This report was grouped on the Supersegment description field. 

o The asset work order cost (AS_WOCOST) was being summed in the group footer.  

o Within the Group Sort Expert the sort was changed to the cost field. 
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Section Expert and Grouping 
If different Heading information is needed for data in the same group, you can use the Section Expert 

to create this affect. 

 

 
o The Select Expert of the report is selecting only records where the following is true. 

  {STSIGNREG.SR_REGS_CD} in [1, 2, 3 TO 12] 

o Each Group Header 2 section is grouping on REGS_CD in the Traffic Regulations table 

(STSIGNREG).   

o Within the Section Expert  each Group Header section has a suppress formula so it will only 

show the records that coincide with that group heading. 

 GH2a suppresses when the following is true: 

   {STSIGNREG.SR_REGS_CD} in [1,3 TO 12] 

  This means that GH2a will show up when the REGS_CD is equal to 2. 

o The other two GH2 sections have different suppression formulas. 

Not only can you have different information in the Group Header sections, you can do this in the Group 

Footer as well. 
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You can use the Section Expert to suppress the different Header and Footer sections.  For example the 

GH1a, GF2a and GF1a all use the following suppression formula: 

{WKRESRCE.WR_RTYP_CD} in [2,3] 

Specific Order of Grouping 
Another report using conditional suppression formulas to show different headers also needed the 

groups to show in a specific order.  

 

 

This was done using the Change Group option.  For Group 2 the following option was used. 
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Percentages 
It is possible to show a value as a percent of a group or of the total using Insert Summary or a formula.  

These options may be used with reports that will not be run with filters on grid (child) fields. 

Percentage with Insert Summary 
In the Work module there is a Work Order Category Summary Report (WOCatSum.rpt) that we will 

find the percent of the total cost of all work orders for that particular category. 

1. From the Work report folder open LC_WOCatSumPerc.rpt. 

2. Modify the existing report to allow room for the new Percent column. 

a. Reduce the CAT_TY field width by moving the right edge to 4”. 

b. Move the Grand Totals text field so that the right edge is also at 4”. 

c. Move the Count of WO’s column so that the right edge is at 5”. 

d. Move the Total Cost column so that the right edge is at 6 ¼”. 

3. Add a text object for the Percent column. 

o Right align at 7”. 
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4. Calculate the value for the Category Cost as a percent of the Total Cost. 

o Click on Insert Summary.  Set up as follows and click OK. 

  

 

5. Move the summary that has been created so that the right edge aligns with the right edge of 

the Percent column. 

 

 

 

Percentage with a Formula 
Continuing with the previous report, we will add the same percent using a formula. 

1. Right Click on Formula Fields and select New. 

2. Type in a name (CatPercent). 

3. Expand Functions > Summary > PercentOfSum 

4. Double click PercentOfSum (fld, condFld) 
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From the Crystal Report Help Guide: 

fld is a Number or Currency field that can be evaluated by the function.  

condFld is a field used to group the values in fld by.  

 The following formula shows in the Workshop window. 

  PercentOfSum (, ) 

5. Expand Report Fields. 

6. The fld to be used is the WO_TOTCOST field. 

o Click just to the right of the left parenthesis. 

o Double click the WO_TOTCOST field. 

7. The condfld group field is WO_CAT_CD. 

o Click just to the right of the coma. 

o Double click WO_CAT_CD. 

8. Click Save and close. 

9. Drag the formula (CatPercent) just to the right of the Percent formula created with the Insert 

Sum tool.                                                                                                                            

10. While the new formula is highlighted, click the percent sign (%) in the tool bar. 

This newly created formula should have the same percent value as the one created with the Insert 

Summary Tool. 

                                                                                                                                        Example 29A 
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Image Reports 
Reports using images can be helpful. There are several imaging reports used throughout the Sewer 

modules.  At this time, Lucity Web does not support this type of report. 

The following items are necessary to bring an image into a report. We will look at the TV Observation 

Image Report (TVObsrImg.rpt). 

 

 

 

1. First a Parameter field is set up and must have the Name of GBAMSDOCPATH:   
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2. Then the DocPath formula is created and placed in the Report Header: 

 

  shared stringvar GBADocPath:={?GBAMSDOCPATH}; 

 

3. The Image subreport is in a Group Footer. 

4. The subreport is linked to the main report: 

 
 

5. Within the subreport’s Select Expert is the following selection criteria: 

 
 {SWDOC.DOC_PATH} Like ['*.jpg', '*.bmp', '*.jpeg', '*.tif', '*.tiff', '*.TGA', '*.PNG'] 

 and 

 {SWDOC.KEY_ID} = {?Pm-SWTVOBSR.TO_OBS_ID} and 

 {SWDOC.CHILD_TABLE} = "SWTVOBSR" 

 
Note: Some Oracle versions are case-sensitive.  The image may not show if the Path 
extension case does not match exactly. It may need to be changed to: 

UpperCase({SWDOC.DOC_PATH}) Like ['*.JPG', '*.BMP', '*.JPEG', '*.TIF', '*.TIFF', '*.TGA', 
'*.PNG']  
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6. The RelDocPath formula in the subreport Header looks like this: 

  shared Stringvar GBADocPath; 

   GBADocPath 

 

7. The image is in an OLE object in the Detail section. Right click the object, select Format 

Graphic, and then click on the Picture tab. 

 

        

 

8. Click the formula button next to Graphic Location. The following formula appears: 

  shared stringvar GBA DocPath; 

  if left ({SWDOC.DOC_PATH},13) = "$GBAMSDOCPATH" 

  then {@RelDocPath} + right ({SWDOC.DOC_PATH}, (Len ({SWDOC.DOC_PATH})- 

  13)) 

  Else {SWDOC.DOC_PATH} 

 

9. To suppress the Detail section when there is no image: 

a. In Section Expert click on the Details a section. 

b. In the Suppress (No Drill-Down) formula box there is a formula. 

 isnull ({SWDOC.DOC_ID}) 
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Hyperlinking 
 

Modules can have documents attached to them.  A client wished to have a link to these documents in 

the Daily Inspection Detail Report.   

A Notification subreport was added.  The subreport used the WKDOC table.  It was linked as follows: 

 

 
The subreport was set up like this: 

 

 
 

o Within the Select Expert the formula looked like this: 

 

  {WKDOC.MODULE_NAME}="WKDAILYI" and 

  {WKDOC.KEY_ID} = {?Pm-WKDAILYI.DI_ID} 

  

o For the DOC_DESC field you right clicked and selected Format Field.   

o Then the Hyperlink tab was selected. 
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o In the File Name Formula Workshop the Document Path field was brought in: 

 

  {WKDOC.DOC_PATH} 

 

o In the subreport Report Header a statement was added so the report user knew what to do to 

access the documents.   

 

 (Double click here to open the Document subreport then click on the document you 

wish to view.) 
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Use of Commands 
If the database you are using supports SQL, you can write your own command which will be 

represented in Crystal Reports as a Table object. This can reduce the size of the data being brought in 

as well as running fields through calculations and groupings before the data runs in the report.  Sorting 

can be an issue when the value to be sorted on is a formula within a group.  The Group Sort Expert can 

be helpful but not all formula fields are available for sorting. 

Commands do not recognize Lucity filters when the report is run.                                                                                                                                    

Here is an example of a report which only used a Command.  

 

 

The report needed to group on the Task but the sort was on the Avg Cost/Unit formula field.  This 

formula was not available in the Group Sort Expert so a Command was used. 

When the report was created and the Data window appeared, instead of selecting tables, the Add 

Command was selected. 

 

The SQL statement was added to the left box. 

 

The values were brought into the report and then the Record Sort Expert was used to sort on the 

CalcUC field. 
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Another case where Add Command is used is when you need to Select records with an OR statement 

that uses fields from different tables.   

To set this up you need to know the required tables, the fields used in the report and the selection 

criteria. 

Here is an example of the SQL statement used to create this type of report: 

 SELECT SWBLDG.*, SWBLDGOB.*, SWBLDGSUMP.BB_STAT_TY, SWNET.NT_BASIN, 
 SWNET.NT_USMAN, SWNET.NT_DSMAN, SWBLDGOB.BO_STAT_TY, 
 SWBLDGSUMP.BB_STAT_TY 

 FROM ((SWBLDG LEFT JOIN SWBLDGOB ON SWBLDG.BD_BLDGID = 
 SWBLDGOB.BO_BLDGID) LEFT JOIN SWBLDGSUMP ON SWBLDG.BD_BLDGID = 
 SWBLDGSUMP.BB_BLDGID) LEFT JOIN SWNET ON SWBLDG.BD_NETID = SWNET.NT_ID 

 WHERE  

 SWBLDGOB.BO_STAT_TY='positive' or 

 SWBLDGOB.BO_STAT_TY='suspect' or 

 SWBLDGSUMP.BB_STAT_TY='positive' or 

 SWBLDGSUMP.BB_STAT_TY='suspect' 
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Duplicate Table Use 
 

Due to Lucity’s flexibility in the use and linking of tables it is helpful that Crystal can accommodate 

most of the relationships. 

Crystal Reports allows the same table to be brought in multiple times into a report by adding a “_#” 

such as “_1” or “_2” to the end of the table name. 

This is helpful when showing the relationship of the structures to the ends of a pipe as seen in the 

Sewer Pipe Detail Report (PipeDet.rpt). 
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Conversions 
 

The fields in Lucity can be a variety of types like numeric, text or datetime.  If the fields are used in a 

formula, then all of the pieces need to be the same type of data.  You can use conversion formulas: 

 ToText(x) 

 ToString(x) 

 ToNumber(x)  -  There could possibly be issues with this formula.  An optional conversion for a  

   string filed is  VAL(x) 

 

To go from all caps to “Normal Text” use the following formula: 

 ProperCase({WKRESRCE.WR_RSRC_TY}) 

 

To get years to show up without a comma: 

ToText(Year ({?Post Date}),0,'') 

 

Odd Things Happen 

Field not showing all of the text 
Check the Field Format Editor in the common tab to make sure the Can Grow option is checked.  If it is 

checked and the field is still cutting off the data then make sure the maximum lines is set at “0”. 

Work – old version (RTDetail.rpt) formatting for the Comments For Crew subreport, CO_TEXT field. 
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Report Takes a Long Time to Open 
If you have a Detail report that takes a LONG time to open, check the UDefs.rpt subreport at the top 

of the report and the Comment subreport at the bottom of the report.  Open the Format Editor dialog 

box for the Subreport and click on the Subreport tab.  Make sure the “Re-import When Opening” check 

box is NOT checked.  Sometimes this option is silver and can’t be changed. 
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Adding Tables 
Bring in all of the tables that could possibly be filtered on in the report. 

The following is a simple Work Order Report with fields from the WKORDER table with only the 
WKORDER table in the Database Expert. 

 

 

 

o If this report is run in Lucity with a filter on Resource Code equal to 1 (employee) then the 

following error will show up and the report will not run.   

 

  

 The error occurs because the WKRESRCE table is not a part of this report. 

o Bring in any tables with possible fields to be filtered on into the Database Expert and Link. 
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The standard Work Order Summary report has the following tables yet only shows fields from the 

WKORDER and WKORDERLOC tables: 

  

 

 In general, the tables are linked with “Left Outer Join” connections.  If the table on the left is 

true then move to the right for the next information.  This shows with an arrow pointing to the 

“Connecting” tables.   

 Inner joins can be used – information in both tables has to exist – but sometimes Crystal has 

some issues with this linking.  This shows with a line with no arrows.   

 Some older reports show all of the connections without arrows even though they are “Left 

Outer Joins”.  If looking at an old standard report and all of the connections look like inner 

joins, check each connection by double clicking each line and finding the Join Type 

description.  

Many items in the Work Order module are found in grids.  Each grid uses a different table. 

 The normal user wants to start grabbing tables, linking and pulling in fields.  As long as you can 

find the correct linking fields this should work, right? Wrong.  There may be issues with 

multiple lines showing and possible problems with running the report with a filter. 

 

A typical field an end user might like to see is the Address.  It will be necessary to bring in the 

WKORDERLOC table to be among the tables in the main body of the report so the report can be run 

with an address filter.  If the address is brought directly in from this table, the following occurs: 

 

 

 The Work Order # 2006-01128 shows up twice because in this record there are two 

addresses in the Address grid.  This might not be a problem to see the work order for 

each location but the Total Cost is going to show up each time as well, which is 

normally undesirable.   
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Possible ways to handle this: 

1. If you want just one of the addresses, you could group on WO_NUMBER and then place all of 

the fields in the Group Header or Footer section.   

 

 

 

o Depending on whether you wish to see the top address or bottom address in the Work Order 

Location grid, you could go into the Record Sort Expert and select the address field to sort on 

in either ascending or descending order. 

 

 

 

2. Another possibility is grouping on WO_NUMBER and then putting the address formula in the 

Detail section. This would allow all of the addresses in the Location grid to show.  
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 There can still be problems if another field from another grid is brought in.  In this next 

example the subtask from the WKWOTSK table is used. 

  

 

 There are three subtasks for this work order and one of the Tasks has two resources.   

So, for each address each task/resource combination is brought in.  You definitely 

don’t want this to happen.  The problem is the way Lucity passes the information over 

to Crystal Reports.  

 

The best way to handle grid information is with subreports.  Both the SubTask and Address 

fields can be put in subreports. 

 

 

 

 

 

 

 

 

Note:___________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________ 

_______________________________________________________________________________

_______________________________________________________________________________ 
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Adding a Comments Section 
The data from the Comment tab within Work Orders and Requests is brought into the report 

differently than the Comment sections in other modules.  For this example, we’ll add a Comment 

subreport to the Work Order Summary Report. 

1. First, we’ll find the field definition for the Work Order Comment section. 

a. Open the Work Orders Standard module.  Click on the Comments tab. 

  

b. Right click in the grid.   

c. Select Add Comment or View Details for an existing comment.   

d. Ctrl + right click in the large comments box to view the field definition.  Note that the 
table name is WKGDMEMO and the field name is GM_MEMO.   

e. Close the comment dialog. 

Note:  This Comment section does not hit the WKMEMO table.  Instead, it uses the 
WKGDMEMO table. 

 

2. Open the Work Orders module’s Report Dialog.   

3. Export the WOSum.rpt report and rename it LC_WOSumComment.rpt.  Open the renamed 
report.  

4. Right click in the left margin of the Group Footer 1a section and select Insert Section Below. 

5. Click Insert Subreport .  

a. In the New report name section, type a name for the subreport (Comment).   

b. Click Report Wizard.   

6. Open Create New Connection>>ODBC>>GBAWork001 (Finish)>>Tables.   

a. Move the WKGDMEMO table to Selected Tables.   

b. Then, choose Finish and OK.   

7. Insert the Comment “box” into the Group Footer 1b section. 

8. Choose subreport formatting options and resize the box. 

9. Right click within the Comment box and select Change Subreport Links. 
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a. Select fields so it looks like the following:  

 

 
b. Click OK. 

10. Double click on the Comment box. You are now in the Comment subreport.  

11. Click Select Expert and add the following to the formula: 

and {WKGDMEMO.GM_PARENT} = "WKORDER" 

o This can be done with the New tab. 

OR 

a. In the Formula Editor > Formula Workshop you can type “and” 

b. Double click the field, WKGDMEMO.GM_PARENT 

c. Type in “=” 

d. Right click on WKGDMEMO.GM_PARENT within the list of fields and click Browse Data 

and select WKORDER, Paste Data. 

e. Select Save and Close and then click OK. 

 

Note:  The formula in Requests would look like this: 

{WKGDMEMO.GM_PAR_ID} = {?Pm-WKREQ.RQ_ID} and  

{WKGDMEMO.GM_PARENT} = "WKREQ" 

 

12. Add column titles.  You’ll want to make the titles bold and underlined in order to make them 

distinct. 
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13. Drag in the appropriate fields.  

o You’ll need to create formulas for the Date and Time fields before adding them. 

14. Increase the size of the GM_MEMO field and format it so it Can Grow. 

15. Place a box around the Comment subreport to separate it from the rest of the data.  Make sure 

the bottom of the box is in the Report Footer section so the box will grow to accommodate the 

Memo field if necessary.  

a. Add a title for the box (Comments).  

b. Format the Comments text box with a white background. 

 

 

16. Click the Design tab.   

17. Click the Section Expert button.   

a. Select Group Footer1b and the Suppress Blank Section option.   

b. Select Group Footer 1 and the Keep Together option.   

c. Then, click OK. 

 

Preview 

 
 

Notes:______________________________________________________________________________

____________________________________________________________________________________

____________________________________________________________________________________ 
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Linking 
When a subreport is added to a report, the linking procedure is usually straight forward; however, 

there are exceptions throughout the Lucity modules.  We previously discussed one such exception: the 

XXMEMO table to the Main table for Comments.  Here, the linking field was not obvious.   

There are other situations where information in a grid requires a go-between table to work with the 

parent module.  When creating a report, this go-between table is required to connect the subreport to 

the main report.  For example, when Work Orders or Requests are linked to Work Orders or Requests, a 

go-between table called WKWOMWO is needed.   

Linking Work Orders to Requests 
In our first step-by-step example, we will link a Work Order subreport to a Request report. 

1. We will modify the Summary of Requests (ReqSum.rpt) report from the Request module.  From 

the Work report folder open LC_ReqSumLinks.rpt. 

2. Open the Database Expert. 

3. Add the WKWOMWO table and link it to WKREQ. 

 The connected fields usually have an ID field with a common part; in this case, it is RQ.  

a. To link the tables, click on the joining field in the “parent” table and drag it onto the 

joining field in the connecting table. 

b. Double click on the joining arrow and select the Left Outer Join Link Option.   

c. Click OK and then click OK again. 
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4. Add a Detail section for the Work Orders subreport. 

5. Create a subreport (Linked Work Orders).   

a. For the Selected Tables, bring in WKORDER and WKWOMWO.  

b. Select Next and link the tables.  Left Outer Join.   

 The “parent” table will be the table that is linked to the main report. (Usually 
placed far left, top) 

c. Click Finish and then click OK. 

  

 

 

6. Place the subreport in the new Details section. 

7. Select the formatting options and resize the subreport.   
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8. Right click in the Linked Work Orders subreport box and select Change Subreport Links.  Set 

up as shown below: 

 

9. Open the Linked Work Orders subreport. 

a. Set up the subreport with the desired information.   

 

 

b. Open the Section Expert in the main report and select Suppress Blank Section for the 

subreport Detail section. 

10. Preview the report. 
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11. In our example, there is an extra space above the first Work Order record.  One way to remove 

this space is to go back into the Linked Work Orders subreport Select Expert and add a 

statement for Work Order IDs greater than zero. 

 {WKWOMWO.MW_MW_ID} = {?Pm-WKWOMWO.MW_MW_ID}  

 and {WKORDER.WO_ID} > 0 

o As you can see in the Preview screen below, this additional statement has removed the 

blank space from above the first Work Order record. 

  

 

o Another way to handle the blank line is to use the Section Expert in the subreport.  

Select Suppress blank section for the Detail section. 

Linking Requests to Requests 
For our next example, we’ll continue with LC_ReqSumLinks.rpt from above.  Here, we’ll add the 

linked Requests. 

1. Add a Detail section beneath the Linked Work Orders subreport.  

2. Insert a subreport named Linked Requests. 

a. For the Selected Tables bring in WKWOMWO and WKREQ.  

 

b. Link as follows: 
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c. Place the subreport in the newly created Detail section. 

d. Select formatting options, and resize. 

3. Right click on the Linked Requests subreport and select Change Subreport Links.  Set up as 

shown below:  

 

o You do not want to show the request you are in when listing linked requests, so an 

additional linking statement needs to be added. 

 

 

4. Open the Linked Requests subreport and click Select Expert. 
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5. You’ll need to modify one of the linking formulas created in Subreport Links. 

 
 {WKWOMWO.MW_MW_ID} = {?Pm-WKREQ.RQ_MW_ID} and 

 {WKREQ.RQ_ID} = {?Pm-WKREQ.RQ_ID} 

 
o Change the second formula to “not equal”. 

o You can do this in the Formula Workshop by highlighting the “=” and then opening 

Operators>>Comparisons and double clicking Not Equal (x<>y).  OR You can just type in 

“<>”.  The “=” will be replaced with “<>”.   

o Remember to Save and Close the Formula Workshop and select OK to close the Select 

Expert.  The new formula will appear as follows: 

 
 {WKWOMWO.MW_MW_ID} = {?Pm-WKREQ.RQ_MW_ID} and 

 {WKREQ.RQ_ID}  <> {?Pm-WKREQ.RQ_ID} 

 
6. Set up the subreport with the desired information.   

7. Go back to the main report and open Section Expert.  Select Suppress Blank Section for this 

new Detail section. 

 

Preview 

 

Linking Requests to Work Orders 
The procedure for adding the linked subreports is very similar to the above examples. 

In this case, we’ll add a Linked Requests subreport to the Work Order Summary Report. 

1. We will modify the Work Order Summary (WOSum.rpt) report from the Work Order module.  

From the Work report folder open LC_WOSumLinks.rpt. 

2. Open Database Expert and add the WKWOMWO table, linking it to WKORDER.  
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3. Add an additional Group footer section beneath GF1a.  This will be the new GF1b. 

4. Create a subreport named Linked Requests with the WKWOMWO and WKREQ tables. 

 



Crystal Reports for Work Orders 16 

5. Insert the Linked Requests subreport into the new GF1b section. 

6. Right click on the subreport and select Change Subreport Links. 

 

7. Proceed with the subreport details as previously demonstrated. 

Linking Work Orders to Work Orders 
We will continue with the open LC_WOSumLinks.rpt report and add a second subreport, Linked Work 

Orders. 

1. Add a new Group Footer section. 

2. Create a new subreport named Linked Work Orders and bring in the WKWOMWO and 

WKORDER tables. 

 

3. Place the Linked Work Orders subreport in the new Group Footer section. 
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4. Right click on the subreport and select Change Subreport Links. 

 

AND 

 

5. Open the Linked Work Orders subreport and click Select Expert. 

6. Change the formula as discussed previously. 

 

{WKWOMWO.MW_MW_ID} = {?Pm-WKORDER.WO_MW_ID} and 

{WKORDER.WO_ID}  <>  {?Pm-WKORDER.WO_ID} 

 

7. Proceed with the subreport details. 

                                                                                                                    Example 30A 
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Work Order Reports with Assets  

Asset Inventory Numbers 
You can use the Asset number for record selection.  By adding a formula in the Select Expert section, 

you can limit records to the desired assets.   

The following Asset values are required to create any formulas that would select specific Assets. This is 

not a complete list. 

 

 

 

Note: These Assets come from the WKCATINV table.   
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Limiting Record Selection to Specific Assets 
We will create a Work Order Summary Report that will show only Sewer Pipe and Manhole work 

orders with their assets. 

1. From the Work report folder open LC_WOSumPipeMan.rpt. 

2. You can view just Sewer Pipe and Manhole records by adding the following formula to the 

Select Expert: 

a. Open Select Expert. 

b. Click on WO_INV_ID. 

 

 
c. Click OK. 

d. Set up as follows. 

 

 
e. Click OK. 

Note: The 6 (Sewer Pipe) and 2 (Sewer Structure) values come from the WKCATINV table on 

the previous page. 
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OR 

a. You can click Report>>Selection formulas>>Record. 

b. Type in the following formula: 

{WKORDER.WO_INV_ID} in [2, 6] 

 

Preview 

 

As you can see in the above example, the new Work Order Summary Report displays only the Sewer 

Pipe and Manhole records. 

Asset Subreports 
We will now add Asset subreports to the limited Work Order Summary Report we created above. 

1. We are going to “borrow” subreports from WOFormSewerAsset.rpt. 

a. Click File in the top tool bar, then Open, and then double click  

WOFormSewerAsset.rpt. 

b. Right click on the SWPipe.rpt subreport. 

c. Select Save Subreport As. 

d. Enter a name for your subreport (SWPipeSub.rpt) and then Save the subreport.  Make 

sure it is saved in the Work report folder. 

e. Repeat these steps for the SWStruc.rpt subreport, giving it a new name as well.  

 For example, we’ve named this subreport, SWStrucSub.rpt. 

Note: When you are finished with these subreports, you may want to delete them from your 

“family” of Work reports.  This will help avoid confusion in the future. 

 

2. Close WOFormSewerAsset.rpt. 

3. You are back in LC_WOSumPipeMan.rpt.  Insert two new Group Footer sections. 

4. In your new Group Footer sections, insert the two subreports using the Choose an existing 

report option. 

5. Choose the subreport formatting options.  Remember to suppress the blank subreports within 

formatting and in the Section Expert. 
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6. Link the subreports. 

 

 

7. Within the subreports, remove the blank sections. 

8. Remove the “old” linking formula in each subreport’s Select Expert. 

 

 

 

Preview 

 

 

                                                                                                                                                  Example 31A 
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Bringing in Asset Work Orders  
In a Work Order report with Assets, it is sometimes desirable to see all of the Work Orders associated 

with the Assets.  This is helpful in determining if the asset is being plagued with problems. 

1. From the Work report folder open LC_WOSumPipeManWOs.rpt.  We will set up the Pipe asset 

subreport (SWPipeSub.rpt) to bring in any associated work orders. 

 The original tables for this subreport are linked as follows: 
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2. Additional tables are needed.  Bring in WKORDER and an additional WKWOASSET which will 

show as WKWOASSET_1.  Left outer joins. 

 

 

3. Grouping should be added for the AS_LINK1 field.  The fields in the Detail section will be 

moved into the Group Header section. 

4. Bring in the WO_NUMBER field and the WO_ACTN_TY field into the Detail section. 

5. Create a formula (WOTitle) that will show when there are any other work orders associated 

with this asset: 

 If {?Pm-WKORDER.WO_ID} <> {WKORDER.WO_ID} then "Additional Work Orders" 

6. Group on this formula so that it will show only once for a list of work orders. 

7. In the subreport Section Expert click on the Group Header #2 section and select Suppress Blank 

Section. 

8. In the subreport Section Expert add a conditional suppression formula for the Details section.   

  {?Pm-WKORDER.WO_ID} = {WKORDER.WO_ID} 

 This will suppress the work order number the asset is associated with in the main report.  
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The Pipe subreport now looks like this: 

 

 

Preview 
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Bringing in Comments for the Asset Work Orders 
To view the comments that are associated with each Asset work order we will continue with 

LC_WOSumPipeManWOs.rpt. 

1. The Work Order Comment is shown by bringing in the WKGDMEMO table then linking to the 

WKORDER table.  Left outer join. 

 

 

 

2. Create a new group on the WO_NUMBER field. 

3. Move the data in the Detail section into the new Group Header section (GH3). 

4. Add the GM_MEMO field to the Detail section.  

5. In the subreport Section Expert for Group Header #3, add the following formula to Suppress. 

 {?Pm-WKORDER.WO_ID} = {WKORDER.WO_ID} 

 Also select Suppress Blank Section. 
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6. In the subreport Section Expert for Details: 

a. Add the following formula to Suppress. 

 ({?Pm-WKORDER.WO_ID} = {WKORDER.WO_ID}) 

 Or ({WKGDMEMO.GM_PARENT} <> "WKORDER") 

b. Also select Suppress Blank Section. 

 

 

Preview 
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Filter on Grid Fields and the Impact on Reports 
If you have a module that allows you to filter on a field that is in a grid with multiple records and you 

plan on running a report (without groupings) with this field as a filter, then the report may have some 

issues.  If you have a field you wish to summarize, you need to set it up with groupings and variables or 

running totals.   

For example, in a Work Order report where the fields have been placed in the Detail section without 

Grouping - the following could occur: 

Filter on a grid field that has multiple values and run the report against this filter and see what the 

numbers do.  Resource = 1 (employee) is a good one. 

The filter can be found when you click Advanced. 

 

Then click on the “Report SQL” tab.   

Lucity passes to Crystal the following statement. 

{WKRESRCE.WR_RTYP_CD} = 1 

When the report runs, it looks at the record every time the statement is true.  If a report had three 

employees then it would hit the record three times. 

In WO# 2006-01128 there are two employees so when the report is run with a resource filter the work 

order line shows up twice. 
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If the information being summarized is in the WKORDER table, then grouping on the WO_NUMBER and 

setting up variables should be sufficient.  If you are summarizing a field within Task or Resources you 

will need to further group.  In most cases using a Running Total is equally effective as the variables. 

Using Variables in a Report 
The original Work Order Category Summary (WOCatSum.rpt) report looked like this: 

 

 

It was a very simple report which grouped on Category and used the Crystal Summary tool to calculate 

the Group Total and Grand Total.  This worked when the report was run without filters.   

 

There were certain filters that caused duplicate Work Order costs.  The problem filters are the fields 

that come from grid data.  In the Work Order module these would include Location, Assets, Tasks and 

Resources.  This occurs because of the filter statement being passed from Lucity to Crystal.  If there 

are two Tasks on a Work Order that are true for a Task filter being run then the report will run the 

record twice.   

When the report was run with a resource filter on Work Orders that have employees these same 

categories looked like this: 

 

There is an obvious difference in the cost fields.  Instead of possibly going down due to records being 

filtered out that had no employees, the cost actually went up. Some work orders had multiple 

employees so the cost  was summed each time the filter was true.  The count was calculated using the 

Distinct Count option as opposed to the Count option for calculating so there was no duplication of 

records. 
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To correct this issue we used grouping and variables.   

 

 

Open WOCatSum.rpt and follow the steps used to correct the report. 

 

 

1. Add a second grouping on the Work Order Number, WO_NUMBER. 

2. Create a formula for the Work Order Cost (WOCost) and place it in the WO Number Group 

Footer 2. 

WhilePrintingRecords; 

Shared numberVar WOCost ; 

WOCost:={WKORDER.WO_TOTCOST} 

3. Create a formula to summarize the cost for the Category (CatWOSum). Add a new section 

below the WO Number Group Footer 2.  This is a second Group Footer (GF2b) for this section.  

Place this new formula in this section. 

WhilePrintingRecords; 

Shared numberVar CatTot ; 

Shared numberVar WOCost ; 

CatTot:= CatTot + WOCost 

4. Create a formula to summarize the total cost for all Work Orders (TotSum).  Place this in GF2b. 

WhilePrintingRecords; 

Shared numberVar TotWOCost ; 

Shared numberVar WOCost ; 

TotWOCost:= TotWOCost + WOCost 
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5. Create a formula to reset or zero the Work Order cost variable (ZeroWO).  Place this in the WO 

Number Group Header #2 section. 

WhilePrintingRecords; 

Shared numberVar WOCost:=0; 

6. Create a formula to reset the Category Cost variables (ZeroCat).  Place this in the Category 

Group Header #1. 

                   WhilePrintingRecords; 

       Shared numberVar CatTot:=0; 

7. Create a formula to show the Category total cost (CategoryTot).  Place this in the Category 

Group Footer #1. 

                  WhilePrintingRecords; 

                  Shared numberVar CatTot ; 

                  CatTot 

8. Create a formula to show the Grand Total Cost (Total).  Place this in the Report Footer. 

WhilePrintingRecords; 

Shared numberVar TotWOCost ; 

TotWOCost 

9. Suppress the new Group Header and Footer sections. 

It depends on the report as to whether you use variables or running totals to solve filter issues.  At the 

time the report was revised the use of variables was the choice method to correct the issue. 

Variables are also very useful to pass information from a subreport to the main report.   

Sometimes with complex reports variables are necessary to calculate the data correctly. 
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U sing Running Totals in a Report 
The same report could have been modified using Running Totals to correct the filtering issue.   

1. The additional grouping on the Work Order number is still necessary. 

2. Two Running Totals are created.   

o One for the Category cost (CatCost). 

 The Evaluate is set up as “On change of group” and the group is “Group #2”, 

the Work Order Number. 

 The Reset is set up as “On change of group” and the group is “Group #1”, 

Category. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Crystal Reports for Work Orders 32 

o The second running total is to calculate the cost grand total (TotCost). 

 

 It Evaluates on the same group as the Category cost running total but the Reset 

is Never. 
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Secured Fields  

Secured Fields in the Main Body of Report  
Sometimes, fields should be hidden in reports if the person viewing the report does not have the proper 

level of security.  This can be done by using parameters and formatting options.  

Note:  This will only work for fields in the main body of the report.  Fields that need to be 

hidden in subreports will be addressed next. 

 

Many cost fields in Work Order reports are set to use the “Hidden” option.  Sometimes you may wish to 

suppress the fields completely. 

The following steps are provided to set up the field security. 

1. Right click Parameter Fields and select New.   

2. Type in the Name - ViewSecuredFields.   

 This is a special parameter field that must have this name “ViewSecuredFields”.          

When the report is run within Lucity, the security is passed to the report and will 

not query the user.  If the report is run outside of a Lucity module, in Crystal, then 

the security will be queried. 

 If the report is refreshed, it will ask for the parameters again, including the 

permission to view the secure fields.  At this point you can change the security 

value the report will run with. 

3. Select the Type > Number and under Options > Discreet Value -True.  

4. Click OK.   

Field Viewing Options 

 Field to Show Blank 

 For a blank field to show up when the user does not have rights to view the secured fields, do 

 the following:  

1. Right click the field that requires suppression and select Format Field.   

2. Click the Common tab.   

3. Click the formula box  next to Suppress.  

4. Double click the ViewSecuredFields parameter from the Report Fields.   

5. Type “= 0”. 

{?ViewSecuredFields} = 0 

6. Click Save and close. 

7. Click OK 
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  Field to show “Hidden”  

For the word “Hidden” to show up when the user does not have rights to view the secured 

fields, do the following:  

1. Right click in the field that requires suppression and select Format Field. 

2. Click the Common  tab 

3. Click the formula box  next to Display String. 

4. Type in: 

if {?ViewSecuredFields}=0 then "Hidden" else "$"& totext(the field that is to show) 

Note: The inclusion of the dollar sign is because once the formula brings in the word 

“Hidden”, the formula requires the outcome to be text.  The field will not allow number 

formatting.  That is also the reason for the conversion of the field to text. 

5. Click Save and Close. 

6. Click OK 

It would be helpful to make a notation at the bottom of the report to explain why some of the fields 

are “Hidden”, such as: 

“A Hidden field indicates permission to view the secured field is turned off.” 

Secured Fields in Subreports 
The ViewSecuredFields parameter is sent to the report from the Lucity software security setup.  This 

parameter value only reaches the main body of the report.  In order for a subreport to use this value it 

needs to be passed into the subreport as a variable.  

 

We will look at the Work Order Detail Report (WODetail.rpt) and see how security was added to the 

cost fields in the Task/Resource subreport. 

1. First, we used a shared variable called Security.  It was declared in both the report and 

subreport. 

o Open WODetail.rpt.  The ViewSecuredFields parameter was created.   

o A new formula was created called Security to declare the variable. 

 Shared NumberVar Security:= {?ViewSecuredFields}; 

2. The new Security formula was placed into the Report Header section.  The field size was 

reduced and the field text formatted to have white font.  This ensured that the formula was 

not visible in the report. 

3. In the TaskRes.rpt subreport a new formula called SecuritySub was created.   

             Once again, the Security variable was declared. 

   Shared NumberVar Security; 

o The formula was dragged into the suppressed Report Header. 
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4. There are four fields set up to show “Hidden” if the user does not have proper security.  These 

are designated with asterisks (Cal’c UC, Task Costs, Unit Cost and Total Cost).  

Variables – Passing information from a 

subreport to the main report 
Let’s create a report that shows the number of Requests and Work Orders for each Request Problem 

type.  The number of Requests is straightforward enough with the use of a Running Total field.  The 

number of Work Orders gets a little trickier because Work Orders are attached to Requests through a 

grid and thus need to be brought into the report as a subreport.  Information from a subreport to a 

parent report can be done by using variables. 

1. Create a new Work Report from the Crystal Report Blank Report option and name it 

LC_ReqSumRQWO. 

2. Bring in the WKREQ table.  Bring in the Problem field (RQ_PROB_TY) and the Request 

Number (RQ_NUMBER): 

3. Group by Problem Type.   

4. Move the Problem field to the Group Footer. 

5. Add a Number of Requests column title.  

6. Add a Problem column title.  

7. Create a Distinct Count of the Request Numbers for each Problem Type and place it under the 

column header in the Group Footer section. 

8. Add a “Total” text in the Report Footer section.  Then put in a Distinct Count of the Request 

Numbers into the Report Footer. 

9. Add a Report Title “Summary of Requests and Work Orders”. 

 

 

10. Add the WKWOMWO table in the Database Expert and link as shown earlier in this document. 

11. Add a Group on Request Number. (GH2) 

12. Add another Group Header 2 section (GH2b). 

13. Create a Work Order subreport with the WKORDER and the WKWOMWO tables and place it in 

the Group Header 2b section (GH2b).  Link tables and subreport as shown earlier in this 

document (Work Order to Request). 
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14. In the subreport, drag the WO_Number field into the Detail section. Create one formula 

WOCount  

 WhilePrintingRecords; 

  Shared numberVar WOCount; 

  WOCount :=DistinctCount({WKORDER.WO_NUMBER}) 

15. Place the formula and the WO_NUMBER field as follows and suppress the subreport sections.  

This subreport is counting the Work Orders for each Request.  WOCount is a shared variable 

that is available to the main report. 

 

  

16. In the main report create a column header, Number of Work Orders. 

17. Create the next five variable formulas and place in the report as shown in the example.  
 

 

 

WOSum   (WOCount is being summed to calculate the Problem Total for Work Orders  

  and the Grand Total for Work Orders.) 

 WhilePrintingRecords; 

 Shared numberVar WOCount ; 

 Shared numberVar ProbWOCount ; 

 Shared NumberVar GrTotWOCount; 

 
 ProbWOCount:=ProbWOCount + WOCount; 

 GrTotWOCount:=GrTotWOCount + WOCount; 
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ProbTot 

 WhilePrintingRecords; 

 Shared numberVar ProbWOCount; 

 ProbWOCount 

 

TotalWO 

 WhilePrintingRecords; 

 Shared numberVar GrTotWOCount; 

 GrTotWOCount 

 

ZeroWO 

 WhilePrintingRecords; 

 Shared numberVar WOCount :=0; 

 

  ZeroProb 

 WhilePrintingRecords; 

   Shared numberVar ProbWOCount :=0; 

 

18. In Section Expert, make sure you select Suppress Blank Section for the GH2b section with the 

Work Order subreport. 

o Suppress sections as follows: 

 

 

Note: The GH2b section must not be suppressed in order to pass the subreport information 
to the main body of the report. Within the subreport all sections may be suppressed. 
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Preview 

 

                                                                                                                                                  Example 32A 

Notes:______________________________________________________________________________

____________________________________________________________________________________

____________________________________________________________________________________ 

____________________________________________________________________________________

____________________________________________________________________________________ 
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Work Order Subtask Information to Assets 
The Work module now allows Subtasks to be assigned to specific Assets.  In order to show these 

relationships in a report, some fairly odd table links are required. 

 

 

This seemingly simple one line report took nine groupings and two subreports to get to the information. 

 

 

 

Notes:______________________________________________________________________________

____________________________________________________________________________________

____________________________________________________________________________________ 

____________________________________________________________________________________ 
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Inventory Reports with Work Order Subtask 

Information 
In Lucity version 7.4 or newer, the availability of the WKTSKAST and WKWOTSK tables in the list of 

synonym tables allow the addition of subtasks when creating reports for the various inventory items. 

 

 

This too had some interesting table links: 

 

This report had five groupings and three subreports to assist the information out of the tables and into 

the report.  

If you are interested in creating a report with this subtask information, contact Lucity Support and we 

can help step you through the process. 

 



Crystal Report Examples – Advanced Training 

XXII.  Example 22A 
 

Modify the Request List Report (ReqList.rpt) to limit the Category to Sewer 

Department, Group on Problem and add a graph. 

 

Original (ReqList.rpt) 

 
 

Change to (CT_ReqListProbGraph.rpt) 

 
 

Solution 

 

1. From the Request module export ReqList.rpt and name the new report 

CT_ReqListProbGraph.rpt. 
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2. Open CT_ReqListProbGraph.rpt and remove the Save Data with Report 

option. 

3. Click on Select Expert and limit the Category Code (RQ_CAT_CD) to 20000.  

This will bring in just the Sewer Department category. 

 Remove the Category header title and field. 

4. Group on the Problem text field. 

a. Click on the Problem field (RQ_PROB_TY)  

b. Click Insert Group 

c. OK 

d. Left align the Group Name field with the Title. 

e. Remove Problem header title and field. 

5. Rearrange the Column headers and fields to match the “Change to” example.  

a. Header information bold. 

b. “Comments for work Order” in italic. 

6. Change Comment subreport text to italic. 

7. Change title to “Request List Report by Problem – Sewer Department” 

8. Add count of Request Number (RQ_NUMBER) and place in the Problem Group 

Footer. 

9. Add text field to Problem Group Footer “Number of   Requests”.    

a. Drag the Problem text field (RQ_PROB_TY) between “of” and 

“Requests”.   

b. Right align field. 

c. Increase text box width. 

10. Unsuppress the Report Footer and increase the size to 3”. 

11. Add a Bar graph. 

a. Click Insert Chart. 

b. Click in the Report Footer to place the chart. 

c. In Chart Expert remove the Auto-Text checks and change the text for the 

Title, Group Title (x) and Data Title (y).  See “Change to” example. 

d. OK 
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12. Remove the Group (Problem) axes names. 

a. Click on a Group axis name to highlight. 

b. Right click in the highlighted box and select Format Axis Label… 

c. Under Color select Transparent. 

d. OK 

13. Move the Group axis title (Problem) up closer to the graph by click and drag. 

14. Change the line in the Detail c section to black. 

15. Increase the space of the Group footer 1 section to about 3/8”. 
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XXIII.  Example 23A 
 

Modify the Sewer Pipe Summary Report (PipeSum.rpt) to group by Material and Pipe 

Diameter.   

Use a doughnut graph to show percentage of the number of pipes of each diameter for 

each material type. 

 

Original (PipeSum.rpt) 

 
 

Change to (CT_PipeMatDia1.rpt) 

 
 

Solution 

 

1. From the Sewer Report folder, open CT_PipeMatDia1.rpt. 

2. Remove Width, Length, Sec Length and Liner column header and fields. 

3. Move Material column next to the Dia/Ht column. 

4. Drag the right report edge marker to 8 1/8” (to reduce line size and Header 

information.) 

5. Reduce the Report Subtitle box to 7”. 
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6. Increase the Title box to 7”. 

7. Change the title to “Sewer Pipe Sizes for Material Types”. 

8. Change the Page Setup to Portrait. 

9. Center the page number. 

10. Group on Material (NT_MAT_TY). 

11. Group on Diameter (NT_DIA). 

12. Count the number of pipes for the Diameter group. 

a. Click on the Pipe ID field (NT_ID). 

b. Click on Insert Summary. 

c. Set the summary to Count. 

d. Set the Location to Group 2 (Diameter). 

e. OK 

13. Increase the Group Footer 1 section to 3”. 

14. Insert Chart into the Group Footer 1 section. 

15. In Chart Expert under Type, select Doughnut. 

16. In Chart Expert, Data tab, Select Group Layout.   

17. Confirm the Data as On change of Diameter (NT_DIA) Show the count of the 

pipe ID (NT_ID). 

18. In Chart Expert under Text, change the Title to read Percent of Pipe Diameter. 

19. Suppress Group Headers 1 and 2, Detail and Group Footer 2 sections. 

20. Remove the column headers and line beneath them. 

 Close up the Page Header to about 1”. 

21. Change the Graph Subtitle font. 

a. Click on the graph Subtitle (For @NT_MAT_TY). 

b. Right click and select Format Subtitle… 

c. Change to Bold and Color Black. 

d. OK 

22. Remove the value in the Center of the doughnut. 

a. Right click on the chart and select Chart Options… 

b. Under Data labels, uncheck the Show Pie Total option. 

c. OK 
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XXIV.  Example 24A 
 

The report created in Example 23A showed the Legend in ascending order by pipe 

diameter.  In this example we would like the Legend to show in order of percent.  

 

Original (CT_PipeMatDia1.rpt) 

 
 

Solution 

 

1. Use a Copy of CT_PipeMatDia1.rpt and name it CT_PipeMatDia2.rpt. 

2. Change the Summary field to show as a percent. 

a. Right click on the summary field and select Edit Summary... 

b. Under Options check Show as a percentage of. 

c. The drop down box should show Group #1. 

d. OK 

3. Change the sort for the report. 

a. Click on the summary field. 

b. Click on Group Sort Expert . 
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c. OK 
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XXV.  Example 25A 
 

We will add a crosstab to the Request Summary Report (ReqSum.rpt).   

The report will query a date range and list the employees in the Recorded By field 

(RQ_REC_BY) and show for each day the number of requests created.   

The report will show only the crosstab. 

 

Original (ReqSum.rpt) 

 
 

Change to (CT_ReqByDt.rpt) 

 
 

Solution 

1. In the Work Report folder, open CT_ReqByDt.rpt. 

2. Keep the RQ_NUMBER and @ReqDate fields; remove all other fields and all 

Column Titles. 

3. In the Report Footer section remove the Total Requests text box and summary 

field. 

4. Reduce the width of the Page Header and Footer sections to 8”. 

5. In Page Setup change the orientation to Portrait. 

6. Change the title to “Daily Number of Requests Summary”. 

7. Add Start Date and End Date parameters. 

a. In Field Explorer right click on Parameter Fields. 

b. Type in a Name (Start Date) and select the Type (Date). 

c. OK 

d. Repeat for End Date. 
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8. Use the Date parameters to select records. 

a. In Select Expert click on . 

b. OK 

c. From the drop down box select is between. 

d. Then select the two parameter fields (Start Date and End Date). 

e. OK 

9. Increase the Report Footer section to 1”. 

10. Add a Cross-Tab. 

a. Click on the Insert Cross-Tab button or in the menu bar click on Insert > 

Cross-Tab… 

b. Click in the Report Footer section to place the crosstab. 

11. Set up the Cross-Tab. 

a. Right click in the top left corner of the Cross-Tab and select Cross-Tab 

Expert… 

b. Set up Columns (@ReqDate), Rows (WKREQ.RQ_REC_BY) and 

Summarized fields (Count of WKREQ.RQ_NUMBER) 

c. In the Customize Style tab review the options and make sure the Column 

Totals on Top and Row Totals on Left are unchecked. 

d. OK 

12. Add a text field to the top left box that says “Recorded By”. 

13. Suppress the Detail section. 

14. Preview and adjust cell sizes. 

15. Change the font of the Total cells to bold. 
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XXVI.  Example 26A 
 

A cross-tab and bar graph will be added to the Backflow Preventer Summary Report 

(wtbfsum.rpt). 

 

1. In the Water Report folder, open CT_wtbfsumCTGr.rpt. 

 

2. Create a Cross-Tab and place it in the Report Footer.  The Cross-Tab should 

show the Type (BF_TYPE_TY)field in the Columns, the Size (BF_SIZE) field 

in the Rows and a Distinct Count of the Device (BF_NUMBER) field in the 

Summarized Fields. 

a. Unsuppress the Report Footer section. 

b. Insert a Cross-Tab into the Report Footer section. 

c. Within the Cross-Tab right click and select Cross-Tab Expert… 

 

 
 

 

 

 

 



ExA-XXVI-12 

 

 

d. Within the Customize Style tab, set the totals to be on the right and the 

bottom. 

 

  
 

e. OK 

3. Add another Report Footer section. (RFb) 

 

4. Add a bar graph to this section.  The Data should use the Cross-Tab with the “On 

Change of” being the Type field, Subdivided by Size and Showing the distinct 

count of Device number.   
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a. Insert a graph into the Report Footer b section. 

b. In the Chart Expert set the Data tab up as follows: 

 

  
 

c. OK 

 

5. Right click in the chart and select Chart Options…  

a. In the Legend tab the Color Mode should be on Color by Series. 

b. In the Titles tab change the Title to read Device Count of Type and Size. 

c. Change the Group Title to read Type and Size. 

d. Change the Data Title to read Number.   

e. OK 
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6. Right click on a Group (X) axis label and select Format Axis Label. 

a. Change the Rotation to 45.   

b. OK 

7. Click and drag the Group Title to avoid the labels if necessary. 

 

Design 
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Preview 
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XXVII. Example 27A 
 

We will add to the Employee Cost List Report (EmpCostList.rpt) the Work Orders 

each Employee has worked on.  Then set it up to hide the Work Orders unless called on. 

 

1. In the Work Report folder, open CT_EmpCostListWO.rpt. 

   

2. Change the title to Employee Cost List Summary with Work Orders. 

 

3. In the Database Expert bring in the WKORDER and WKRESRCE tables. 

 

4. Link 

 

 
 

5. Group on the Employee Code (EM_EMPL_CD). 

 

6. Move the Employee data to the Group Header 1 section. 

 

7. Bring the Work Order Number (WO_NUMBER) field into the Detail section. 

 

8. In Section Expert click on the Details section and then select Hide (Drill-Down 

OK). 

 

9. Suppress the Group Footer 1 Section. 
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When the report is run it will look like the original Employee Cost List Report.   

 
 

If you double click on an employee name it will show the Work Orders the employee 

has worked on. 

 
 

It would be helpful to state to the user how the hidden information is shown. 
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XXVIII. Example 28A 
 

We will create a Work Order Task Labor Cost Summary report which shows 

Category subtotals as well as the total.  This could easily be done with Running Totals 

but this should be done with variables. The intent is to guide you through the basic use of 

variables. 

 

1. Create a new Work report called Work Order Task Labor Cost Summary 

(CT_WOTskLabCostSum.rpt).  You may use the Report Wizard (then modify) 

or Blank Report.  Use the following tables: 

 WKORDER  

 WKWOTSK 

 WKRESRCE 

 WKORDERLOC 

 WKWOASSET 

 

2. Link  

 

 
 

3. Bring in the following fields. 

 WO Number 

 Problem 

 Main Task 

 Labor Cost  (WKORDER.WO_LC_ACT using variables to declare and 

sum) 
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4. Group on Main Task. 

 

5. Group on WO Number. 

 

6. Put in a subtotal for Main Task (variable). 

 

7. Select on Closed Work Orders, STAT_CD>950. 

 

8. Put in a Grand Total (variable). 

 

9. Add Dollar symbol ($) to the cost fields. 

 

Set up the fields as follows: 

 
 

Suggested Formulas: 

LaborCost 

 WhilePrintingRecords; 

 shared numbervar LabCost; 

 

 LabCost:={WKORDER.WO_LC_ACT} 

------------------------------------------------------------------------------------------------------- 

LaborSum 

 WhilePrintingRecords; 

 shared numbervar LabCost; 

 shared numbervar TskTot; 

 shared numbervar GrTot; 

 

 TskTot:=TskTot + LabCost; 

 GrTot:=GrTot + LabCost; 

------------------------------------------------------------------------------------------------------- 

TaskTot 

 WhilePrintingRecords; 

 shared numbervar TskTot; 

 

 TskTot 
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GrandTot 

 WhilePrintingRecords; 

 shared numbervar GrTot; 

 

 GrTot 

------------------------------------------------------------------------------------------------------- 

ZeroTask 

 WhilePrintingRecords; 

 shared numbervar TskTot:=0; 
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XXIX.  Example 29A 
 

We will modify the Sewer Pipe Summary report (PipeSum.rpt) to group by pipe 

material and then show the sum of the pipe length and the percentage for that material 

type.  The Summary Tool should be used to calculate the percentage. 

 

 
 

1. From the Sewer Report folder, open CT_SWPipeMat.rpt.   

 

2. Change the title to Sewer Pipe By Material Summary Report. 

 

3. Add a Group on the Material field. 

 

4. Add the group option to Repeat Group Header On Each Page. 

 

5. Add a summary for Pipe Length for each Material Type. 

 

6. Using the Summary tool add a Percent for Pipe Length for each Material Type.  

 

If the previous summary formula is still where Crystal placed it then the Percent 

formula will be placed on top of it.  Click and drag on the formula field to 

separate them. 

 

7. Add a text object with “Total” and the Material field embedded to restate the 

material type in the Group Footer. 

 

8. Add a top Border to the length summary. 

 

9. Add a line to separate material type sections. 
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XXX.  Example 30A 
 

We will modify the Summary of Requests report (ReqSum.rpt) to show the number of 

days between when the Request is created and the Work Order is created.  This will be 

done without the use of subreports but using the table linkings just learned. 

 

1. From the Work Report folder, open CT_ReqWODays.rpt. 

 

2. Change the title to Days For Request to Work Order. 

 

3. Bring in the following tables: WKORDER, WKWOMWO and WKWOMWO 

again. 

 

4. Link 

 
 

5. Change the Priority column to WO Number. 

 

6. Change the Problem column to WO Creation Date. 

 

7. Create a date formula (WODate) to bring in the WO_INIDATE field. 

 

8. Create a column to the right of WO Creation Date for “Req to WO”. 

 

9. Create a formula (DateDiff) to find the difference between the WO creation date 

(@WODate) and the Request creation date (@ReqDate). 

 

 {@WODate}-{@ReqDate} 
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XXXI. Example 31A 
 

We will modify the Work Order Summary Report (WOSum.rpt) by adding assets and 

limiting it to show only Sewer Assets.  The Assets will be brought in with grouping 

instead of a subreport.  This will allow the Asset filters in Lucity to be applied to the 

report. 

 

 
 

1. From the Work Report folder, open CT_WOSWAssetSum.rpt. 

 

2. Change the title to Work Order with Sewer Assets Report. 

 

3. In Select Expert add a formula to limit the work orders to those with Sewer 

Assets.  (The asset numbers can be found in the WKCATINV table.) 

 

 {WKORDER.WO_INV_ID} in [2, 232, 233, 234, 235, 3, 4, 5, 6] 

 

4. Add a group on the Asset ID (WKWOASSET.AS_ID). 

 

5. Unsuppress the Group Header 1 section.  

 

6. Move the Work Order data from the GF1a section to the GH1 section. 

 

7. Delete the GF1a section. 

 

8. Add a Group Header 1 section (GH1b). 

 

9. Add to the GH1b section Asset column headers; Asset Type, System ID 1,  

Desc 1 and Desc 2.  Underline, Italic and not bold. 

 

10. Add the appropriate Asset fields to the Group Header 2 section. 

 

11. Suppress the Group Footer 2 section. 
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XXXII. Example 32A 
 

We will modify the Work Order Summary With Asset Report (WOSumAsset.rpt)  to 

bring in Sewer and Storm Pipes and show their lengths with a total combined length. 

 

  

1. From the Work Report folder, open CT_WOSwSmPipeSum.rpt.   

 

2. Change the title to Work Orders with Sewer and Storm Pipes Report. 

 

3. In Select Expert add a formula to limit the work orders to those with Sewer and 

Storm Pipe Assets.  (The asset numbers can be found in the WKCATINV table.) 

 

 {WKORDER.WO_INV_ID} in [26, 6] 

 

4. Using the Save Subreport As… option, save a copy of the WOAsset subreport in 

the Work Report folder (WOSmAssetSub). 

 

5. Add a Group Footer 1 section below GF1c.  

 

6. Add a subreport to the new section (GF1d).  Choose an Existing Report 

(WOSmAssetSub).  Format 

 

7. Link the new subreport to the WKORDER table. 

 

8. In the new subreport (WOSmAssetSub) delete the two added blank sections. 

 

9. In the WOSmAssetSub subreport’s Select Expert, remove the additional linking 

formula. 

 

10. In this same Select Expert, limit the records to the Storm Pipes. 

 

 {WKWOASSET.AS_CAT_INV} = 26 

 

11. Rename the other Asset subreport to WOSwAsset. 

o This is done in the Subreport’s Format Editor > Subreport tab > Subreport 

options > Subreport Name box.   
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12.  In the Select Expert for the WOSwAsset subreport, limit the records to the Sewer 

Pipes. 

 

 {WKWOASSET.AS_CAT_INV} = 6 

 

13. In WOSwAsset add the Sewer Pipe table and link. (Remember to use the Views 

for the Work Database) 

  
14. Change the Cost column to “Length”. 

 

15. Bring in the Length field (NT_LENGTH). 

 

16. Create a Running total for the Length field (SwLength). 

 

17. Create a formula (SwTot) to have a variable use the running total field.  Place in 

the Report Footer a section. 

 

  WhilePrintingRecords; 

  shared numbervar SwTotL; 

  SwTotL:={#SwLength} 

 

18. Create a formula to reset the variable – just to be safe (Zero).  Place in the Report 

Header a section. 

 

  WhilePrintingRecords; 

  shared numbervar SwTotL:=0; 
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19. Set up the Storm subreport similarly. 

 
 

 
 

20. In the main report add a new Group Footer section below GF1d.  Suppress 

21. Create two formulas to bring in and sum the sewer and storm pipe lengths.  Place 

in the GF1d section. 

 

SwLengthSum 

 

 WhilePrintingRecords; 

 shared numbervar SwTotL; 

 Shared numbervar WOSwTot; 

 WOSwTot:=WOSwTot + SwTotL; 

 

SmLengthSum 

 

 WhilePrintingRecords; 

 shared numbervar SmTotL; 

 Shared numbervar WOSmTot; 

 WOSmTot:=WOSmTot + SmTotL; 

 

22. Create two formulas to state the sewer and storm pipe total lengths.  Place in the 

Report Footer. 

 

SWPipeL 

 

 WhilePrintingRecords; 

 Shared numbervar WOSwTot; 

 WOSwTot 
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SMPipeL 

 

 WhilePrintingRecords; 

 Shared numbervar WOSmTot; 

 WOSmTot 

 

23. Create one more formula to state the total length of all pipes.  Place in the Report 

Footer. 

 

 TotalPipe 

 

  WhilePrintingRecords; 

  Shared numbervar WOSwTot; 

  Shared numbervar WOSmTot; 

  WOSwTot + WOSmTot 
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